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Chapter 1

Introduction1

PolyServe Understudy provides failover protection for network servers and 
services. It does this by combining servers in logical clusters that support 
virtual hosts—hosts that continue to provide network services should one of the 
underlying servers, or a service running on it, go down.

This document provides detailed information on installing and configuring 
PolyServe Understudy. Additional information is available in Understudy’s 
on-line help facility and in the Release Notes that accompany the software. For 
information, connect to the PolyServe Web site at www.polyserve.com.

Terminology
The following terms are used in this document in accordance with the 
definitions given here.

Understudy—The Understudy software in its entirety is simply referred to as 
Understudy. Functionally, Understudy has two main parts—the server daemon 
(spare) and the console GUI (understudy). Once configured, the server 
software runs automatically on server start-up, and you can access the console 
GUI at any time.

Cluster—A cluster consists of two network servers running Understudy. The 
servers may run any of the supported operating systems. The servers can use 
the same operating system, or they can use different operating systems.

Virtual Host—Understudy provides failover protection for one or more virtual 
hosts. A virtual host is a hostname/IP address that may move from one real 
server to another. Understudy uses dynamic IP address assignment to switch 
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traffic from a malfunctioning server in a cluster to the other server, and so 
maintain virtual host accessibility independent of any single server failure.

Primary and Backup Servers—Normally, Understudy routes network traffic 
for the virtual host to the server that is designated as the primary server for that 
virtual host. If Understudy determines that there is a server or service failure 
on that primary server, it redirects traffic for the virtual host to the other server 
in the cluster, which is the backup server. Additional virtual hosts may be 
configured for the same cluster, and either server may be primary or backup 
for these virtual hosts. Neither server needs to be dedicated for Understudy, 
and both can support other, independent, functions.

Active and Inactive Servers—At any given time, the active server is the one 
receiving the network traffic for a virtual host. The active server is normally 
the primary server, but if Understudy has redirected traffic to go to the backup 
server, the backup server becomes the active server. The inactive server is the 
one not currently receiving network traffic for a virtual host.

Services and Service Monitors—A service is any network service, such as 
Web (HTTP) or an FTP service, that is installed and configured on the servers. 
In addition to monitoring the functioning of the servers, Understudy can be 
configured to watch specific services with service monitors. Understudy will 
transfer traffic from one server to the other when a service monitor indicates 
that a particular service is not functioning properly on a server. It would 
transfer the traffic, for example, if Netscape or Apache were to fail.

Load Balancing or Load Sharing—a cluster can also be configured so that 
each server receives an equal share of the traffic. Simple load sharing is 
available in recent releases of DNS/BIND (BIND 4.9 or higher). Combined 
with Understudy, load sharing can be set up so that DNS sends requests to 
active servers only.

Document Summary
This chapter is designed to introduce Understudy concepts and terminology, 
and also help you make the necessary decisions to design effective protection 
for your network services.
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Chapter 2, Installation, documents the installation procedure to be performed 
on each network server.

Chapter 3, Configuration, steps through an example configuration of a simple 
Understudy cluster, and then illustrates some additional configurations.

Chapter 4, Console Reference, provides details on every menu option 
available through the Understudy console GUI.

Chapter 5, Maintenance and Troubleshooting, describes the few maintenance 
procedures that can be performed to maintain Understudy, and also lists 
possible error messages with explanations.

Understudy Overview
Figure 1-1, “Functioning Understudy Cluster”, illustrates a basic Understudy 
cluster. It represents a single virtual host, acme.com, which is supported by 
two servers, acme1 and acme2.

Figure 1-1. Functioning Understudy Cluster

acme1 acme2

IP Traffic 
for acme.com

Primary Server Backup Server
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Figure 1-2, “Understudy Cluster with Primary Server Down”, illustrates how 
the backup server takes over for a failure in the primary server.

Figure 1-2. Understudy Cluster with Primary Server Down

The “backup” server in a cluster such as the one shown in Figure 1-1 and 
Figure 1-2 does not have to be dedicated to the backup function—it may well 
be an active server performing many functions on a routine basis, only 
doubling as a backup for the primary server should the need arise.

In fact, the two servers in a cluster may be configured to back-up each other, 
or back-up particular services for each other. 

For example, both servers might be Web servers: one, with the virtual host 
name sales.acme.com, could be the primary Web server for the company’s 
sales people, and it would be backed-up by the other server. The other server 
might have the virtual host name support.acme.com, and be the primary 
Web server for the support group. If either of the servers or services running 
on the primary servers goes down, Understudy would switch traffic to the 
other server. In this case, the cluster is configured as two virtual hosts, and the 
underlying servers are each primary for one virtual host and backup for the 
other.

Or, one server may be the primary FTP server, ftp.acme.com, and the other 
the primary Web server, www.acme.com, and Understudy could be configured 
to have the FTP server function as the backup Web server, and the Web server 
to function as the backup FTP server. 

acme1 acme2

Primary Server Backup Server

IP Traffic 
for acme.com
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There are many different possibilities. You may have up to 128 virtual hosts 
configured on any one cluster, and virtual hosts may support multiple services.

The following section discusses issues to consider regarding hardware and 
software design of Understudy clusters.

Cluster Design 
Considerations
Understudy provides failover for network servers and services based on the 
assignment of virtual hosts to clusters. 

The basic requirements for Understudy are:

● Two servers: The servers must run Linux, NT, FreeBSD, or Solaris 
operating systems, but they do not both have to run the same one.

● Ethernet: The servers must be connected with Ethernet or Fast Ethernet.

● TCP/IP networking: The servers must be network hosts on the same 
TCP/IP subnet.

● Understudy: Understudy must be installed on both servers.

● Virtual Host: One or more virtual host names and IP addresses must be 
assigned. A virtual host is in every way similar to a normal host name. It 
has a unique IP address and appears to all who access it as a host machine. 
The difference is that a virtual host can be switched by the Understudy 
software to another host machine in the cluster.

Multiple virtual hosts can be defined per cluster. This is ideal for ISPs and 
other service providers that support multiple sites or applications on a 
group of servers.

Choosing Understudy Servers
The servers you choose to configure into an Understudy cluster should be 
properly configured as fully networked hosts supporting the services you 
desire before installing Understudy. For example, if you want Understudy to 
provide failover protection for your Web service, the two servers you use 



1-6 Introduction

C L U S T E R  D E S I G N  C O N S I D E R A T I O N S

should be set up as Web servers with Apache, Netscape, Microsoft IIS, or 
whatever server software you use. 

Note: Understudy does not provide any database management or data 
mirroring functionality. You must configure your software to update data 
between servers as your needs require.

Fault-Tolerance
An easy way to ensure that both servers serve the same data is to configure 
them, for example with NFS, to access the same data on the same disk. The 
disadvantage of this method is that if the disk malfunctions, both the primary 
and backup servers are disabled.

The more physically independent the servers in an Understudy cluster are, the 
more reliable the virtual host. If the primary and backup servers have separate 
uninterruptible power supplies (UPSs) and separate disks, the failure of any 
one of these components will only affect the single server, allowing 
Understudy to maintain uninterrupted service on the virtual host.

Load Distribution
If you configure Domain Name Service (DNS) to use the round-robin 
technique of distributing network traffic between multiple servers, Understudy 
can provide higher availability. Without Understudy, round-robin DNS is 
vulnerable to service failure: if a server goes down, some fraction of requests 
still go to the unavailable server and will be unanswered. However, if the IP 
addresses in the round-robin pool are Understudy-protected virtual hosts, then 
the loss of a server will not cause requests to go unanswered.

For example, you could configure two servers with two virtual hosts so that 
each server is the primary server for one virtual host and the backup server for 
the other. If you create a DNS round-robin pool consisting of the two virtual 
hosts, in normal operation, roughly half the requests will go to one server and 
half to the other. If a server should fail, all the requests would go to the 
remaining server until the failed server resumed functioning.
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Configuring Understudy for load distribution (also called load balancing or 
load sharing) is discussed in Chapter 3.

Migrating Existing Network Servers to 
Understudy
In some cases, before configuring Understudy, the name of an existing server 
was the one published as the network host providing one or more services. 
With Understudy, the actual names of the servers should be separate from the 
name of the virtual host which they support. This enables the virtual host to 
respond regardless of the state of any one of the servers.

You have the choice to re-assign the public name of the server to the virtual 
host, which is generally the better solution, or to keep the name of the 
published server associated with the particular server which presents a 
different situation. Both alternatives are described below.

To migrate an existing server name to an Understudy virtual host name, you 
will have to change the name of the server to something else. External sites 
that then try to access the same server name will actually be served by the 
virtual host—basically, a failover-protected version of the server, with no 
difference in appearance to the clients.

If you want to keep the existing server name on a server, clients will need to 
use the name of the new virtual host to get benefit from Understudy's failover 
protection. Clients will still be able to access the server by its name, but those 
requests will not be protected by Understudy; if the server fails, requests to the 
server host name will fail, whereas requests to the new virtual host name will 
be automatically redirected by Understudy to the backup server.

Assigning Service Monitors
You can configure Understudy to monitor HTTP (Web), FTP, SMTP (mail), a 
generic TCP service, or any combination of these.

When deciding which services you want to monitor with Understudy, choose 
those services that are most critical to you. There is no point in configuring 
service monitors for services that you do not care about. Not only would that 
unnecessarily increase Understudy’s overhead but, if one of these services 
stops working, Understudy will redirect all of the primary server’s traffic to the 
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backup server—something you would normally want to do only if essential 
services were not working.

When you configure Understudy to monitor a service, that’s all you are doing: 
you are not setting up the service itself. Your servers should be already 
configured to provide the service, for example with Netscape or Apache to 
provide HTTP service. Once you have configured the service, you can 
configure Understudy to monitor it, but the service can run regardless of 
Understudy monitoring. Once you have configured Understudy to monitor it, 
however, and you have informed the service about the virtual host, 
Understudy can quickly switch traffic between servers as required.

Note: This is a key difference between configuring a virtual host and 
configuring a service monitor: When you configure a service monitor with 
Understudy, you only configure Understudy to monitor the service. When 
you configure a virtual host for Understudy, Understudy actually configures 
the server operating systems to respond to the virtual host IP aliases. Refer to 
“Assigning Virtual Hosts” on page 1-9 for more information.

The way Understudy monitors services depends on the service it is 
monitoring:

● To monitor HTTP, Understudy issues a simple HEAD request and waits 
for a reply. If there is no reply, it concludes that the web server is down. 

● To monitor FTP and SMTP, Understudy expects them to send a message 
without being probed. If such a message is not received, it considers the 
service to be down.

● For generic TCP monitoring, Understudy considers the service to be 
functioning as long as a TCP connection can be established with the 
specified server port.

Refer to Chapter 3, Configuration,  for an example of service configuration, 
and “Add Service Monitor to Selected Virtual Host” on page 4-6 for further 
details on adding service monitors.
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Assigning Virtual Hosts
The virtual host names and IP addresses are the names you want to make 
available for users to access services in your network. These names can then 
be dynamically assigned by Understudy to functioning host machines in the 
cluster. By using an Understudy cluster with two servers, the virtual host will 
remain available despite any single service or server failure. Moreover, the 
switch to backup server will be virtually unnoticeable to the client. If HTTP 
service fails during the actual download of a web page to a client, the client 
would receive a “transfer interrupted” message and simply have to reload the 
web page.

When assigning virtual host names, choose some other name than an actual 
server name—the virtual host is independent of a specific server, so the name 
should be as well. For example, acme.com might be the virtual host name for 
the Acme Corporation, and underlying servers, say acme1 and acme2, would 
be known to Understudy but invisible to clients. 

You can configure multiple virtual hosts on each server in a cluster. For 
example, you could configure Understudy so that the virtual hosts 
corporate.acme.com and sales.acme.com are also assigned to the servers 
acme1 and acme2, in addition to the virtual host acme.com. You can define up 
to 128 virtual hosts per cluster, thus enabling you to host multiple web sites 
per server with high availability for each of them.

When assigning an IP address for the virtual host, it must be in the same 
subnet as the servers in its cluster.

When you have decided on virtual host names and IP addresses, inform your 
DNS name service so that it will support them.

Chapter 3, Configuration, gives an example of a virtual host configuration, 
and “Add Virtual Host” on page 4-5 provides details on how to configure 
Understudy to support your virtual host. Note that Understudy will configure 
the server operating system to respond to the virtual host name and address 
once it has been so configured, and you should not directly modify your 
operating system start-up files or use ifconfig to support the virtual host. 
Once you have configured Understudy, though, you must configure the 
particular network service software (for example, Apache web server) on both 
servers, to respond to the virtual host.
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This chapter presents procedures for installing Understudy software on your 
servers. Understudy must be installed on all servers in the cluster. You should 
first read “Before You Begin”, and then follow the instructions for installing 
Understudy on the particular operating system each server is running.

This chapter provides installation instructions for the following operating 
systems and specialized servers:

● Red Hat Linux

● Slackware Linux

● Debian Linux

● Cobalt servers

● SUN Solaris

● FreeBSD

● Windows NT

Note: All required files are included with the software distribution. Be sure to 
read the release notes to check the specific files to use for a particular 
installation.
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Before You Begin
Installation requires root privileges on each server on which Understudy is to 
be installed. See the release notes for any new information before beginning 
the installation. The release notes are included in the software distribution. 
You can see the most recent release notes on-line at the PolyServe website, 
www.polyserve.com/releasenotes.html.

The complete installation and configuration of an Understudy cluster can be 
summarized in these steps:

1. Ensure that all real server names and all virtual host names are fully 
defined in the name server or in the local host files.

Virtual host names and IP addresses must be unique. No duplicate real or 
virtual name or IP address can exist in the network.

2. Install and configure Understudy on all servers to be in your 
Understudy cluster.

3. If you plan to run Understudy on a server without a monitor, you 
must install the Understudy Administrator GUI on another host. 
This software is available at 
www.polyserve.com/dnload_gui.html

4. Use the Understudy console to configure the Understudy cluster 
with virtual hosts and service monitors for failover operation and 
load balancing.

Installation On Linux
Servers that run the various Linux operating systems have similar installation 
procedures, with slight variations. This section provides instructions for the 
following Linux systems:

● Red Hat

● Slackware

● Debian
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● Cobalt servers

Red Hat Linux
The Understudy Red Hat distribution contains the following files: 

● understudy-1.3-x.redhat-y.z.i386.rpm—a Red Hat Package Manager (RPM) 
file that can be installed on a Red Hat host. The filename includes an 
Understudy upgrade release number, indicated here as “x,” and a Red Hat 
Linux release number, indicated here as “y.z.”

● understudy.pdf—this administrator’s guide in PDF format

● README—contains the latest release notes.

Be sure to read the README file for any additional information.

You can obtain the latest readme file and any necessary documentation from 
www.polyserve.com/releasenotes.html.

The minimum requirements for Red Hat are

● Intel 486 compatible or later

● Red Hat 6.0 or later

● 16MB of memory

● 25MB disk space

● Ethernet 10/100 port

To install Understudy on Red Hat
Log on as root and enter the following from the directory where you have the 
package

root> rpm -i understudy-1.3-x.redhat-y.z.i386.rpm

where x is the Understudy upgrade release number and y.z is the release of 
Red Hat Linux. 

Repeat this process on any other server that uses Red Hat Linux and will run 
Understudy. Understudy must be installed on both servers in every cluster you 
plan to configure. The servers may use different operating systems.
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To assign a password
Once the installation is complete, assign a password for Understudy 
administration. Use the sppasswd utility, which comes with Understudy.

To set the “admin” user password, enter the following:

root> sppasswd

sppasswd> admin mypassword

where mypassword is the password you want to use.

Understudy’s GUI administration console prompts for this password when 
connecting to the Understudy server. You can change the password at any 
time with the sppasswd command. Note that you must assign the password 
for Understudy administration on each server on which you have installed 
Understudy.

To start and stop the Understudy daemon
When Understudy is installed, it automatically starts the Understudy daemon 
process. If you need to start and stop the daemon subsequently, do the 
following: 

root> /etc/rc.d/init.d/spare start

root> /etc/rc.d/init.d/spare stop

To uninstall Understudy
To uninstall Understudy, enter the following from the directory where you 
have installed Understudy:

root> rpm -e understudy

To start the Understudy GUI console
To start the Understudy GUI console, start the windowing environment and 
type the following:

$ understudy

The console login screen appears.
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Slackware Linux
The Understudy Slackware distribution contains the following files: 

● understudy-1.3-x.slackware-y.z.i386.tgz—a tarball that can be extracted by 
the installpkg utility. The filename includes an Understudy upgrade 
release number, indicated here as “x,” and a Slackware Linux release 
number, indicated here as “y.z.”

● understudy.pdf—this administrator’s guide in PDF format.

● README—contains the latest release notes.

Be sure to read the README file for any additional information.

You can obtain the latest readme file and any necessary documentation from 
www.polyserve.com/download.html.

The minimum requirements for Slackware are

● Intel 486 compatible or later

● Slackware 4.0 or later

● 16MB of memory

● 25MB disk space

● Ethernet 10/100 port

To build a new kernel
The generic kernel that comes with the Slackware distribution doesn’t have 
the IP Alias module installed.

Understudy uses the IP Alias feature to implement virtual hosts, so a new 
kernel must be built. Do so by configuring, building, and installing a new 
kernel under /usr/src/linux.

For information, see /usr/src/linux/README and
/usr/src/linux/Documentation.
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To install Understudy on Slackware
Log on as root and use the installpkg command to install the tarball, for 
example:

root> installpkg understudy-1.3-x.slackware-y.z.i386.tgz

(where x is the latest Understudy upgrade release, and y.z is the latest 
Slackware release). The tarball contains a shell script that installpkg runs 
which sets up the files /etc/rc.spare and /etc/rc.M to start spare 
automatically after reboot.

Repeat this process on any other server that uses Slackware Linux and will 
support Understudy. Understudy must be installed on both servers in every 
cluster you plan to configure. The servers may use different operating systems.

To assign a password
Once the installation is complete, assign a password for Understudy 
administration. Use the sppasswd utility, which comes with Understudy.

To set the “admin” user password, enter the following:

root> sppasswd

sppasswd> admin mypassword

where mypassword is the password you want to use.

Understudy’s GUI administration console prompts for this password when 
connecting to the Understudy server. You can change the password at any 
time with the sppasswd command. Note that you must assign the password 
for Understudy administration on each server on which you have installed 
Understudy

To start and stop the Understudy daemon
When Understudy is installed, it automatically starts the Understudy daemon 
process. If you need to start and stop the daemon subsequently, do the 
following: 

root> /etc/rc.d/rc.spare start

root> /etc/rc.d/rc.spare stop
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To uninstall Understudy
To uninstall Understudy, enter the following from the directory where you 
have installed Understudy:

root> removepkg understudy-1.3-x.slackware-y.z.i386

(where x is the latest Understudy upgrade release and y.z is the latest Slackware 
release).

To start the Understudy GUI console
To start the Understudy GUI console, start the windowing environment and 
type the following:

$ understudy

The console login screen appears.
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Debian Linux
The Understudy Debian distribution contains the following files: 

● understudy-1.3-x.debian-y.z.i386.deb—a debian package that can be 
extracted by the dpkg utility. The filename includes an Understudy 
upgrade release number, indicated here as “x,” and a Debian Linux 
release number, indicated here as “y.z.”

● understudy.pdf—this administrator’s guide in PDF format.

● README—contains the latest release notes.

Be sure to read the README file for any additional information.

You can obtain the latest readme file and any necessary documentation from 
www.polyserve.com/releasenotes.html.

The minimum requirements for Debian are

● Intel 486 compatible or later

● Debian 2.1or later

● 16MB of memory

● 25MB disk space

● Ethernet 10/100 port

Caution: Understudy uses the IP Alias feature to implement virtual hosts. 
When configuring the kernel, make sure that the IP Alias module is 
loaded.

To install Understudy on Debian
Log on as root and use the dpkg command to install the package, for example:

root> dpkg --install understudy-1.3-x.debian-y.z.i386.deb

(where x is the latest Understudy upgrade release and y.z is the latest Debian 
release). Repeat this process on any other server that uses Debian Linux and 
will support Understudy. Understudy must be installed on both servers in 
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every cluster you plan to configure. The servers may use different operating 
systems.

The package uses shell scripts to configure Understudy. These scripts set up 
files in /etc/init.d and /etc/re?.d to start spare automatically after 
reboot.

To assign a password
Once the installation is complete, assign a password for Understudy 
administration. Use the sppasswd utility, which comes with Understudy.

To set the “admin” user password, enter the following:

root> sppasswd

sppasswd> admin mypassword

where mypassword is the password you want to use.

Understudy’s GUI administration console prompts for this password when 
connecting to the Understudy server. You can change the password at any 
time with the sppasswd command. Note that you must assign the password 
for Understudy administration on each server on which you have installed 
Understudy

To start and stop the Understudy daemon
When Understudy is installed, it automatically starts the Understudy daemon 
process. If you need to start and stop the daemon subsequently, do the 
following: 

root> /etc/init.d/spare start

root> /etc/init.d/spare stop

To uninstall Understudy
To uninstall Understudy, enter the following from the directory where you 
have installed Understudy:

root> dpkg --remove understudy
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To start the Understudy GUI console
To start the Understudy GUI console, start the windowing environment and 
type the following:

$ understudy

The console login screen appears.

Cobalt Linux Server
The Understudy Cobalt distribution contains the following files: 

● (for Cobalt Qube and RAQ 2 servers) understudy-1.3-x.cobalt.mips.pkg—a 
Cobalt package that can be installed using Cobalt’s administration tool. 
The filename includes an upgrade release number, indicated here as “x.” 

● (for Cobalt RaQ 3i server) understudy-1.3-x.cobalt.i386.pkg

● understudy.pdf—this administrator’s guide in PDF format.

● README—contains the latest release notes.

Be sure to read the README file for any additional information.

Note: You must also obtain the Admin GUI, either the Red Hat or 
Windows 98 or Windows NT version. Download the appropriate GUI version 
from the PolyServe Web site, www.polyserve.com/dnload_gui.html. See 
“To connect the GUI” later in this chapter.

You can obtain the latest readme files and any necessary documentation from 
www.polyserve.com/releasenotes.html.

The minimum requirements for Cobalt are

● Cobalt RaQ 2, Qube, or RaQ 3i server appliance

● 16MB of memory for Cobalt RaQ 2, and Qube, 64MB of memory for 
Cobalt RaQ 3i

● 25MB disk space

● Ethernet 10/100 port
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● Host with monitor to run Understudy Java GUI console

To install Understudy on Cobalt
On the administration page of your Cobalt server, use the Install Software 
menu to install the appropriate PKG file:

● For Qube and RaQ 2 servers, install

understudy-1.3-x.cobalt.mips.pkg

where x is the latest upgrade release.

● For RaQ 3i servers, install

understudy-1.3-x.cobalt.i386.pkg

where x is the latest upgrade release.

Here are the steps:

1. Enter http://yourcobaltbox.com

Where yourcobaltbox is the name of your Cobalt server.

2. Choose Administrator Site from the menu on the left side.

3. Choose Maintenance from the menu on the left side

4. Click the Install Software button.

5. Select the Understudy PKG, enter the administrator’s password, 
and click the Install a ‘.pkg’ Package button.

To assign a password
Once the installation is complete, telnet to the Cobalt box to assign a password 
for Understudy administration. Use the sppasswd utility, which comes with 
Understudy.

To set the “admin” user password, enter the following:

root> sppasswd

sppasswd> admin mypassword

where mypassword is the password you want to use.
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Understudy’s GUI administration console prompts for this password when 
connecting to the Understudy server. You can change the password at any 
time with the sppasswd command. Note that you must assign the password 
for Understudy administration on each server on which you have installed 
Understudy

To connect the GUI
The Cobalt servers have no monitor. Understudy on the Cobalt servers can be 
administered from a remote Understudy GUI client running Red Hat Linux 
6.0 or Windows NT. You will install the Understudy GUI application on the 
client and then connect it to the Understudy daemons on the Cobalt server.

The Understudy Administrator GUI application can be downloaded from:
www.polyserve.com/dnload_gui.html

If you use a Windows 98 or NT client to manage your Cobalt server, install 
the Windows version of Understudy GUI on the PC.

The Windows setup program is understudy-gui-1.3-x-setup.exe, where 
x is the latest upgrade release.

After you have installed Understudy on the Cobalt server, start the Windows 
Understudy GUI. When prompted, enter the IP address of the Cobalt server.

If you use a Red Hat client to manage your Cobalt server, install the following 
RPM file: understudy-gui-1.3-x.redhat.i386.rpm, where x is the latest 
upgrade release.

To start the Understudy GUI console, start the windowing environment and 
type the following:

$ understudy

The console login screen appears.

To use another client as the Understudy console, please contact PolyServe 
directly for access to another supported client.
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To start and stop the Understudy daemon
When Understudy is installed, it automatically starts the Understudy daemon 
process. If you need to start and stop the daemon subsequently, do the 
following: 

root> /etc/rc.d/init.d/spare start

root> /etc/rc.d/init.d/spare stop

To uninstall Understudy
To uninstall Understudy, telnet to the Cobalt server and use the 
cobalt_uninstall command, for example:

cobalt> /usr/local/sbin/cobalt_uninstall understudy

Installation on 
Windows NT
The Understudy Windows NT distribution contains the following files: 

● understudy-1.3-x.nt-4.0.i386.setup.exe—an executable that installs all the 
components of Understudy.

● understudy.pdf—this administrator’s guide in PDF format.

● README—contains the latest release notes.

Be sure to read the README file for any additional information.

You can obtain the latest readme file and any necessary documentation from 
www.polyserve.com/releasenotes.html.

The minimum requirements for Windows NT are

● Intel 486 compatible or later

● Microsoft NT Server 4.0 with Service Pack 3.0 or later (NT Server 
Enterprise Edition is not required)

● 16MB of memory

● 20MB disk space
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● Ethernet 10/100 port

To install Understudy on Windows NT
Copy the understudy-1.3-x.nt-4.0.i386.setup.exe file to a directory 
you want to use for Understudy (where x in the filename is the latest upgrade 
release).

Then double-click the file icon, and follow the directions on the subsequent 
windows.

The installer automatically installs all components.

Repeat this process on any other server that uses Windows NT and will run 
Understudy. Understudy must be installed on both servers in every cluster you 
plan to configure.

Note: After installing Understudy, be sure to create at least one virtual host 
before opening the NT Network Panel.
If you open the Network Panel after installing Understudy before creating a 
virtual host, you will receive the following error message when you close the 
Network Panel dialog box: “The subnet mask that you have entered for the IP 
address is not valid. Please enter a valid mask.” This message refers to one of 
the default IP Addresses created during installation, and it may be ignored. 
When you create a virtual host, Understudy replaces the invalid address.

To assign a password
Once the installation is complete, assign a password for Understudy 
administration. Use the Understudy Password Manager which is installed with 
Understudy.

To set the “admin” user password

1. Choose the Understudy Password Manager from the 
Start>Programs menu.

2. Enter and confirm the password you want to use for the 
Administrator.
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Understudy’s GUI administration console prompts for this password when 
connecting to the Understudy server.

● You can change the password at any time using the Understudy Password 
Manager.

Open the Password Manager from 
Start>Programs>Polyserve>Understudy Password Manager.

Follow the prompts to change the password.

Note that you must assign the password for Understudy administration on 
each server on which you have installed Understudy

To start and stop the Understudy daemon
When Understudy is installed, it automatically starts the Understudy daemon 
process. If you need to start and stop the daemon subsequently, do the 
following: 

1. From Start>Control panel, Open the Services icon.

2. Select the Understudy Cluster Manager service.

3. Use the Start button to start, or use the Stop button to stop, the 
service.

To uninstall Understudy
Use the Windows NT Add/Remove program, available from the Settings 
window, to uninstall Understudy.

After the uninstall process is complete, you need to manually remove the 
Understudy failover driver. To do so,

1. From the Network Panel, open the Adapter Panel.

2. In the Adapter Panel, select the PolyServe Failover Adapter and 
click Remove.

To start the Understudy console login screen
To start the Understudy GUI console, choose the Understudy Browser from 
the Start menu: Start>Programs>Polyserve>Understudy Browser.

The console login screen appears.
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Installation On SUN 
Solaris
The Understudy Solaris distribution contains the following files: 

● understudy-1.3-x.solaris-y.z.sparc.pkg—a package that can be extracted by 
the pkgadd utility. The filename includes an Understudy upgrade release 
number, indicated here as “x,” and a SUN Sparc release number, 
indicated here as “y.z.”

● understudy.pdf—this administrator’s guide in PDF format.

● README—contains the latest release notes.

Be sure to read the README file for any additional information.

You can obtain the latest readme file and any necessary documentation from 
www.polyserve.com/releasenotes.html.

The minimum requirements for Solaris are

● Sparc, UltraSparc

● Solaris 2.6 or higher

● 16MB of memory

● 25MB disk space

● Ethernet 10/100 port

Setting up Solaris for Java
Understudy’s GUI administration console is a Java application. In order to 
run the Java runtime version included with Understudy (JRE version 1.1.8-
09), you’ll need a patch to the Solaris operating system. The patch required is 
106040-11. The patch, with additional information, can be obtained from 
SUN’s Web site, www.sun.com/solaris/jre/download.html.

To install Understudy on SUN Solaris
Log on as root and use the pkgadd command to install the package, for 
example:
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root> pkgadd -d /tmp/understudy-1.3-x.sun-sparc.pkg

(where x is the latest upgrade release). Repeat this process on any other server 
that uses SUN Solaris and will support Understudy. Understudy must be 
installed on both servers in every cluster you plan to configure. The servers 
may use different operating systems.

The package uses shell scripts to configure Understudy. These scripts set up 
files in /etc/init.d and /etc/rc?.d to start spare automatically after 
reboot.

To assign a password

Once the installation is complete, assign a password for Understudy 
administration. Use the sppasswd utility, which comes with Understudy.

To set the “admin” user password, enter the following:

root> sppasswd

sppasswd> admin mypassword

where mypassword is the password you want to use.

Understudy’s GUI administration console prompts for this password when 
connecting to the Understudy server. You can change the password at any 
time with the sppasswd command. Note that you must assign the password 
for Understudy administration on each server on which you have installed 
Understudy

To start and stop the Understudy daemon
When Understudy is installed, it automatically starts the Understudy daemon 
process. If you need to start and stop the daemon subsequently, do the 
following: 

root> /etc/init.d/init.spare start

root> /etc/init.d/init.spare stop

To uninstall Understudy
To uninstall Understudy, enter the following from the root:

root> pkgrm PSspare
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To start the Understudy GUI console
To start the Understudy GUI console, start the windowing environment and 
type the following:

$ understudy

The console login screen appears.

Installation on FreeBSD
The Understudy FreeBSD distribution contains the following files: 

● understudy-1.3-x.freebsd-y.z.i386.tgz—a tarball that can be extracted by the 
pkg_add utility. The filename includes an Understudy upgrade release 
number, indicated here as “x,” and a FreeBSD release number, indicated 
here as “y.z.”

● understudy.pdf—this administrator’s guide in PDF format.

● README—contains the latest release notes.

Be sure to read the README file for any additional information.

You can obtain the latest readme file and any necessary documentation from 
www.polyserve.com/releasenotes.html.

The minimum requirements for FreeBSD (either version 3.2, or version 4.0 or 
later) are

● Intel 486 compatible or later

● Free BSD version 3.2 or later

● 16MB of memory

● 25MB disk space

● Ethernet 10/100 port
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To install Understudy on FreeBSD
Log on as root and use the pkg_add command to install the tarball, for 
example:

root> pkg_add understudy-1.3-x.freebsd-y.z.i386.tgz

(where x is the latest Understudy upgrade release and y.z is the latest FreeBSD 
release). Repeat this process on any other server that uses FreeBSD and will 
support Understudy. Understudy must be installed on both servers in every 
cluster you plan to configure. The servers may use different operating systems.

The tarball contains shell scripts to configure Understudy that are run by 
pkg_add. These scripts set up files to start spare automatically after reboot.

To enable Berkeley Packet Filter (bpfilter)
Understudy uses the Berkeley packet filter during failover, so the bpfilter 
option must be enabled for Understudy to work properly. Version 3.2 of 
FreeBSD defaults the bpfilter option to OFF. Version 4.0 defaults the bpfilter 
option ON.

So, for version 3.2, you need to turn the bpfilter option to ON and recompile 
the FreeBSD kernel. To do so, copy the configuration file /sys/i386/conf/
GENERIC to a new file, turn on the bpfilter option and recompile the kernel.

For information, see www.freebsd.org/FAQ/networking.html#AEN2600.

To assign a password
Once the installation is complete, assign a password for Understudy 
administration. Use the sppasswd utility, which comes with Understudy.

To set the “admin” user password, enter the following:

root> sppasswd

sppasswd> admin mypassword

where mypassword is the password you want to use.

Understudy’s GUI administration console prompts for this password when 
connecting to the Understudy server. You can change the password at any 
time with the sppasswd command. Note that you must assign the password 
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for Understudy administration on each server on which you have installed 
Understudy

To start and stop the Understudy daemon
When Understudy is installed, it automatically starts the Understudy daemon 
process. If you need to start and stop the daemon subsequently, do the 
following: 

root> /usr/local/etc/rc.d/spare.sh start

root> /user/local/etc/rc.d/spare.sh stop

To uninstall Understudy
To uninstall Understudy, enter the following from the root:

root> pkg_delete understudy-1.3-x.freebsd-y.z.i386

where x is the latest Understudy upgrade release and y.z is the latest FreeBSD 
release.

To start the Understudy GUI console
To start the Understudy GUI console, start the windowing environment and 
type the following:

$ understudy

The console login screen appears.
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Chapter 3

Configuration3

This chapter begins with an example of setting up a simple Understudy cluster 
in which a single service is configured for failover. The rest of the chapter then 
expands on this with examples of more complex configurations. The final 
section describes configuring Understudy to provide failover with load 
sharing.

Before You Begin
Understudy allows you to create virtual hosts, complete with IP addresses and 
names, so your users can access your services. A virtual host is a name/IP 
address pair that Understudy uses for its failover operation. A virtual host 
name is also what the client uses to access the server cluster. By using the 
virtual host name rather than the real hostname, Understudy can switch which 
server the virtual host is actually serving.

Before you set up Understudy, choose a name and IP address to use for each 
virtual host you want to configure. The name service you use should be 
configured with these virtual host names. The IP address for the virtual host 
name should be in the same subnet as the servers you will be configuring into 
a cluster. The virtual host/IP addresses must be unique in your network.

In order to configure virtual hosts with Understudy, you should first be sure 
you have the following for each cluster:

● primary server—a network server running the services you want to 
monitor.

● backup server—a network server running the services you want to monitor. 
It should be in the same subnet as the primary server.
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● virtual host—choose a name and IP address to use for each virtual host you 
want to configure. The name service you use should be informed of the 
name and the IP address for that name should be in the same subnet as 
the two servers.

(If you are migrating one or more existing servers to Understudy, refer to 
“Migrating Existing Network Servers to Understudy” on page 1-7.)

● service—the service(s) you want to monitor should be fully operational on 
both servers in the cluster.

A Simple Understudy 
Cluster
Understudy is based on the idea of a cluster, where services are provided by 
one or more virtual hosts. Each virtual host is comprised of a primary server 
and a backup server. The backup server need not be a dedicated server—it 
may well perform other functions on a continuous basis, being called on for 
backup services only when and if the need arises. At that time, it would 
automatically respond to the service requests for the service it is backing-up as 
well as its other duties, and relinquish the new duty when the primary server 
resumes functioning, as determined by Understudy.

As the basic example of an Understudy cluster, we will next configure failover 
support for a company’s Web server.

Note: This example assumes that the Web server daemon, httpd, is properly 
configured and running on the primary and backup servers. Understudy does 
not configure the service itself—it monitors one or more services and 
automatically initiates failover as necessary.

Once Understudy has been properly installed you begin configuring it by 
starting Understudy (refer to Chapter 2, “Installation”).
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In a moment you will see the Understudy console login screen:

If you do not see the login screen, be sure your DISPLAY variable is set 
correctly, and that your system allows you access to the X display.

Enter the name of one of the servers and select OK or press Enter. You next 
see a password screen: 

Enter the password you assigned after installation. You now have access to the 
Understudy console screen:

In the example shown, we have connected to the server acme1 (because we 
specified the server name acme1 in the console login screen). The “OK” 
means that acme1 is up and running the Understudy daemon. The screen 
shows that the cluster now consists of just the one server, acme1. We will now 
configure the cluster further.
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We will now add our second server, in this case a server named acme2. Select 
Cluster->Add Server:

You are prompted for a server name or IP address: 

enter the name or IP address of your second server and select OK. 

We now see the cluster has two servers:
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Now that we have a cluster with two servers, we can add a virtual host. The 
virtual host is the name that will appear in the published URL, and will 
remain the same regardless of which actual server happens to be supporting 
the monitored service at the moment. The name must be recognized by your 
name service, whether by adding it to /etc/hosts, or supplying it with the 
Domain Name Service (DNS) (or whatever name service your subnet uses). 
The IP address for the virtual host must be in the same subnet as the IP 
addresses for the two servers in the cluster.

In this case, our name server has been configured for a host named acme.com, 
and we now inform Understudy of this by selecting Cluster->Add Virtual 
Host...: 

You now see the virtual host configuration screen:

Here you enter the virtual host name or IP address, and also select which of 
the servers you want to be the primary server, and which should be the 
backup server. 
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In this example, the virtual host is acme.com, and acme1 is the primary server 
and acme2 is the backup:

Select OK. We now see our cluster configured with the two servers and a 
virtual host which designates one of the servers as primary and one as backup:

Note that the primary server is marked Active, and the backup server is 
marked Inactive.   This means the primary server is functioning as intended, 
and that the backup server is ready as needed. 
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We now only need to specify which services we want Understudy to monitor. 
To specify a service, select (click to highlight) a virtual host entry and select 
Cluster->Add Service Monitor to Selected Host:

You are prompted for more information:

The Virtual Host field shows the name of the virtual host, the Port field 
displays the default port for the selected service, and radio buttons allow a 
choice of different services. In this example, we are only going to monitor 
HTTP (Web service) with failover, so we select HTTP. (If your HTTP service 
uses a different port than the default, simply replace the Port number 80 with 
the number of the port you use.)
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After choosing the service to monitor, select OK. The console window now 
looks like this:

This is the basic display of a properly configured and functioning Understudy 
cluster of the simplest sort. We see that one service is monitored, HTTP on 
port 80, and that the virtual host is Active on the primary server, meaning it is 
servicing HTTP requests with the primary server, and the backup server is 
OK but Inactive, meaning that the backup server is ready and able to support 
the HTTP service as required.

If, for some reason, the HTTP service on the primary server should fail, 
Understudy would detect this and automatically configure the cluster so that 
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the backup server handled the HTTP traffic. In that case, the console display 
would look like this:

Note that the primary server, acme1, is still up (OK), but the virtual host entry 
for the primary server is marked Inactive and the HTTP service is shown as 
Down. The virtual host entry for the backup server, acme2, is now marked as 
Active, and the HTTP service is shown as Up. Understudy has switched traffic 
to the backup server, and it is now handling HTTP requests. Unless a client 
was in the actual process of downloading a web page at the time of failover, 
they would notice nothing and could continue requesting additional pages and 
so on without interruption. If a download was in process at the time of the 
service failure, the client would receive the ordinary transfer interrupted 
message and simply need to reload the page.
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Once the HTTP service on the primary server resumed, Understudy would 
automatically reconfigure the service to run as before:

After Configuring Understudy
Once you have installed and configured Understudy on your servers and 
created one or more virtual hosts and service monitors, you must configure 
the software you use to provide network services to recognize the new virtual 
host(s).

For example, if you are using the Apache Web server, you may need to edit 
Apache’s configuration files to recognize and respond to the virtual hosts. 
Similarly, if you are using a Netscape Web server, you may need to configure 
it through the administration browser to respond to the virtual hosts. By 
default, FTP responds to any virtual host request it receives.

You should not, however, configure operating system software or files to 
respond to the virtual host—Understudy does that configuration for you. For 
example, do not edit start-up scripts or run the ifconfig command with the 
virtual host information. You only have to inform your monitored services 
about the virtual host. This is so that services running on the server will 
respond to the virtual host requests if Understudy transfers virtual host traffic 
to them.

The rest of this chapter summarizes some other possible configurations, and 
illustrates how they are affected by the loss of particular servers or services.
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Example Cluster 
Illustrations
Figure 3-1 illustrates a cluster in which HTTP, FTP, SMTP, and generic TCP 
services are all monitored by Understudy, and are all configured to run on the 
same primary server and the same backup server.

Figure 3-1. Fully-Functioning Understudy Cluster

In the illustration in Figure 3-1, traffic is being routed to the primary server 
and the backup server is not active. Figure 3-2 illustrates what happens when a 
single monitored service goes down.

Figure 3-2. Understudy Cluster With Monitored Service Down 
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As you can see in Figure 3-2, the loss of a single monitored service causes 
Understudy to switch routing of all virtual host requests from the primary 
server to the backup server. The backup server remains active until the 
malfunctioning service on the primary server again functions properly. 
Understudy restores routing as shown in Figure 3-1 as soon as it determines 
that all monitored functions are responding properly.

Figure 3-3 illustrates a case in which one server in a cluster is the primary 
server for one virtual host and the backup server for another virtual host, and 
the other server performs the opposite functions. In this case, the company 
might have two virtual hosts named something like www.acme.com and 
ftp.acme.com.

Figure 3-3. Understudy Cluster for Different Services

Figure 3-4. Example of Servers Backing-Up Each Other
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In Figure 3-3, we see the normal functioning of this cluster. Figure 3-4 
illustrates the case when a monitored service fails—in this case the FTP service 
on the primary FTP server. Understudy transfers all virtual host traffic from 
the primary FTP server (serv2) to the primary HTTP server (serv1), which is 
also the backup FTP server.

As soon as Understudy determines that serv2 is again responding properly to 
all monitored services, it restores the default functionality shown at the top of 
the figure.

Load Sharing in a Cluster
Understudy can be used to provide failover protection for servers configured 
to provide domain name service (DNS) load sharing using BIND 4.9 or later.

DNS load sharing allows you to set up servers so that requests are sent 
alternately to each of the servers in a cluster. For example, suppose you want 
clients to access acme1 and acme2 one after another so that the two servers 
share the load of accepting and responding to client requests.

BIND 4.9 provides a round-robin feature using address records (A records) to 
alternate requests between IP addresses. If you were to use the round-robin 
feature of DNS without Understudy, you would create two A records as 
follows:

Table 3-1. Configuring address records at the DNS

● Address. These are the virtual host names that customers use to send 
requests to your site. Notice that a mandatory period follows the “.com” in 
the address.

● Time to Live. The number of seconds an address can be cached by 
intermediate DNS servers. This value should be short, so that 
intermediate servers do not cache addresses of servers that are down.

Address Time to

Live

Service Record 

Type

IP Address

www.acme.com. 60 IN A 150.1.1.1

www.acme.com. 60 IN A 150.1.1.2
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● Service. Always IN for internet.

● Record Type. Always A for address.

● IP address. The IP address for the virtual hosts you will use for each 
server in the cluster. These are the IP addresses that the DNS will use to 
send alternate requests.

DNS round-robin supports pools of servers for any application, including 
web, email, ftp, and database. Most Linux systems and Solaris support BIND 
4.9 and later versions. Be sure to check with your vendor to ensure that your 
operating system supports BIND 4.9. Some operating systems require specific 
maintenance upgrades. For example, Windows NT requires service pack 4 for 
round-robin support.

Using the A records in your name server configuration is a straightforward 
way of gaining load-sharing capability and simplified load balancing, resulting 
in improved response speed.

Understudy provides failover protection to a load sharing configuration. 
Without Understudy, requests are simply alternated between the servers. If a 
server goes down, requests to that server do not connect.

To configure for round-robin load sharing, you define virtual hosts as 
addresses in the A records on the DNS. Then you use Understudy to associate 
primary and backup servers to that virtual host. In essence, you use the virtual 
host capability of Understudy to accept the round-robin requests sent by the 
DNS. Understudy handles the failover function to the real servers in the 
cluster.

For a full discussion of load sharing with Understudy, see the white paper at 
www.polyserve.com/PDFs/white_dns.pdf.
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Here is an example of configuring two servers to accept round-robin requests. 
You start by defining a cluster with the servers you want to use, in this 
example, acme1 and acme2, as shown in Figure 3-5.

Figure 3-5. Cluster defined for load sharing

Suppose you will use virtual_acme1 and virtual_acme2 as the addresses 
on the name server. You would create two virtual hosts for your cluster with 
those names. The first virtual host would use acme1 as the primary server and 
acme2 as the backup. The second virtual host would use acme2 as the primary 
and acme1 as the backup. The final setup is shown in Figure 3-6.

Figure 3-6. Cluster with two virtual hosts
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Finally, you would configure the DNS server for round robin, using the 
following A records:

Table 3-2. Configuring address records at the DNS

The result of this setup is that the domain name server sends messages to the 
two virtual hosts indicated by the IP addresses in a round-robin fashion, thus 
having the virtual hosts share the request load. Each virtual host has a single 
primary server on which it performs the work, and has the other server as 
backup in case the primary goes down or is taken off line for maintenance.

Address Time to

Live

Service Record 

Type

IP Address

www.acme.com. 60 IN A 150.1.1.1

www.acme.com. 60 IN A 150.1.1.2
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This chapter describes every menu option available through the Understudy 
console GUI. The console GUI is the utility that allows Understudy 
administrators to configure the cluster for proper operation. The console GUI 
is a Java application that is included in the release of each version of 
Understudy. It can be run on any server that is running Understudy, except 
those servers that do not have monitors. A monitor is mandatory to run the 
console GUI. For servers that do not have monitors, PolyServe provides a 
separate administration console GUI that you can download from our web 
site at www.polyserve.com/dnload_gui.html.  This separate utility runs on 
the following platforms (which you can directly download):

● Windows 98/NT at www.polyserve.com/dnload/understudy-gui-
1.3-setup.exe

● Red Hat Linux 6.x at www.polyserve.com/dnload/understudy-gui-
1.3-1.redhat.i386.rpm

This section discusses how to start and operate the Understudy GUI, and all 
commands discussed work for both the separate console admin GUI and the 
embedded admin GUI in Understudy.

Starting the Console GUI
To start an instance of the Understudy console GUI on Unix, FreeBSD, or 
Linux, run the command understudy on a network server or X terminal. If 
you do not see anything happen, be sure your DISPLAY variable is set 
appropriately.
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Note: To access menus in the Understudy GUI, move the mouse cursor over 
the menu item and press the left mouse button or, if you prefer to use the 
keyboard, hold down the Alt key while you press the underlined letter in the 
menu item (some window managers may trap these keystrokes, in which case 
you will have to use the mouse). Select specific items by clicking on them with 
the left mouse button, or press the key shown as underlined in the menu 
options.

To start an instance of the Understudy console GUI on Windows NT or 98, 
choose the Understudy Browser from the Start menu: 
Start>Programs>Polyserve>Understudy Browser.

The console login screen appears. 

File Menu Options 
The File menu allows you to open and close clusters and to exit from 
Understudy.
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Open Cluster
Select File->Open Cluster to open a connection to a cluster:

Enter the name or IP address of one of the servers in the cluster and select 
OK. If you do not have a cluster, enter the name of one of the servers that you 
want to be in the cluster.

If you already have a cluster open and you try to open a new cluster, you will 
be prompted if you want to close the currently open cluster: 

Select Yes to close the connection to the current cluster or No to keep the 
current connection.

You may only have one cluster open at a time in an Understudy console. If 
you want to work with another cluster simultaneously, open another 
Understudy console with the understudy command at the command line.

Close Cluster
Select File->Close Cluster to close a connection to a cluster. You will be 
prompted to confirm:

Select Yes to confirm or No to return to the cluster connection.
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Note: The cluster continues to operate whether or not you have an open 
console connection to it.

Exit
Select File->Exit to end the Understudy console session. You will be prompted 
to confirm:

Select Yes to exit from the program, or No to continue viewing the 
Understudy console.

Cluster Menu Options
The Cluster menu allows you to add and delete servers, services, and virtual 
hosts:
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Add Server
Select Cluster->Add Server to add a server to a cluster:

Enter the server name or IP address of the server you want to add and select 
OK, or select Cancel to cancel the server addition.

Note: The current version of Understudy supports no more than two servers 
per cluster, and the servers must be on the same subnet. Refer to “Cluster 
Design Considerations” on page 1-5 for more information.

You do not need to add the server to which you connected when you 
performed the File->Open Cluster operation.

Note: Adding a server to a cluster does not configure services on the server, 
nor does it configure disk mirroring or any other scheme to maintain duplicate 
data across servers. Refer to “Cluster Design Considerations” on page 1-5 for 
more information.

Add Virtual Host
Select Cluster->Add Virtual Host to add a virtual host (sometimes referred to 
as a “protected IP address”) to a cluster. You may have up to 50 virtual hosts 
on a cluster.

You will be prompted to specify the virtual host:
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Enter the host name or IP address for the virtual host. This host must have an 
IP address on the same subnet as the server(s) in the cluster. 

Note: Do not configure this IP address in the operating system with ifconfig 
or any other tool or in any system start-up script. Understudy will configure 
the operating system appropriately to support the virtual host. You will, 
however, have to configure individual services to inform them of the virtual 
host(s) when Understudy configuration is completed (see “After Configuring 
Understudy” on page 3-10 for more information.)

Select one server as primary by clicking on the associated button. The primary 
server is the one that will normally receive the service requests for that virtual 
host. Should that server be unable to support those requests, Understudy will 
automatically route those requests to the backup server.

Select OK to add the virtual host configuration, or Cancel to cancel the 
operation.

Refer to “Cluster Design Considerations” on page 1-5 for more information.

Add Service Monitor to Selected 
Virtual Host
Select Cluster->Add Service Monitor to Selected Virtual Host to configure 
monitoring for a particular service. You must select (highlight) the virtual host 
entry in the console for this selection to be presented in the Cluster menu.

You will be prompted for service information:
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Select the type of service you want to monitor. Understudy will supply the 
default port number for the service you select—if your service is configured to 
use a different port than the default, you should enter that port number here.

Note: You can repeat this process to configure a cluster to monitor multiple 
services. If one of the services fails on the primary server, the requests for ALL 
protected services on the same virtual host will be routed to the backup server 
until all services are again available on the primary server. 

Adding a service monitor for a service only configures Understudy monitoring 
of that service. It does not configure the service itself. Refer to “Cluster Design 
Considerations” on page 1-5 for more information.

Delete Selected Server/Virtual Host/
Service Monitor
Select Cluster->Delete Selected Server (or Virtual Host or Service Monitor) to 
delete an entry from the cluster you are viewing. You must have selected 
(highlighted) the object in the console display before making the delete 
request. You are then prompted to confirm, for example:

Select Yes to delete the entry, or No to cancel the operation.

Note: You cannot delete the server you used to connect to the cluster. If you 
want to delete that server, close the cluster and open it again by specifying the 
other host. Then delete the server.
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Update Selected Virtual Host
Select Cluster->Update Virtual Host to change the primary and backup server 
positions. This is the proper way to bring down a primary server, for example, 
for maintenance. Once the primary server has been configured as backup, and 
the backup server as primary, traffic is routed to the new primary server until 
failover, so you can take down the former primary server without interruption 
to the supported service(s). But even if you do not perform this procedure to 
seamlessly switch servers, and just take down the primary server, Understudy 
would simply switch traffic to the backup server just as it would in a failover, 
and any delay would be slight and generally unnoticeable.

Server Log Menu Options
To access the Server Log menu option, you must first select (highlight) a server 
entry in the console display:
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Read
Select Server Log->Read to open a view of the server log for the selected 
server. For example:

This displays the last 100 lines of the server's log file (/var/log/polyserve/
spare_log.dat) in reverse order, so the most recent entries are displayed 
first. Scroll bars allow you to move up and down in the file, as well as left and 
right to see the entire message without resizing the window.

Set Maximum Length
Select Server Log->Set Maximum Length to truncate the log file at a certain 
length: 

The default length of the server log is 1000 lines. If you are short of space on 
the server, you may want to keep this file short, but of course you then save 
less log information for that server.

When the server log file reaches its maximum length, the current log file is 
copied to the backup file (spare_log.dat is copied to old_spare_log.dat), 
and the 100 oldest lines in the current log file are removed. 
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Note that each server maintains its own log file, and that any changes you 
make with this option only refer to the server that is highlighted when you 
select the option.

Truncate
Select Server Log->Truncate to truncate a log file. You will be prompted to 
enter the number of lines to delete from the log file. 

The current log file is copied to the backup file (spare_log.dat is copied to 
old_spare_log.dat), and the oldest number of lines entered here are 
removed from the current log file.

Note that each server maintains its own log file, and that any changes you 
make with this option only refer to the server that is highlighted when you 
select the option.

Help Menu Options
Select Help to see the Help options:
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About
Select Help->About for the Understudy version and copyright information.

Help
Select Help->Help to view the on-line help:

You can then click on particular entries in the table of contents, or use the 
buttons at the top of the window to page through the help or exit as desired.
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The Login and Password 
Screens
The login and password screens are the ones you first see when you start 
Understudy with the understudy command.

The login screen prompts for a server to connect to:

Enter the name of a server in the cluster or, if you want to create a new cluster, 
enter the name of one of the servers to be in the new cluster.

The password screen comes up when you request a server connection: 

Enter the password you have assigned for that server (see next).

The password prompt or password change screen appears when you request it 
as root with the sppass command:

$ su -
<enter the server’s root password>
# sppass

For Windows NT, choose Understudy Password Manager through the Start 
menu.
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Enter the old password for the Understudy administrator, and then enter the 
new password twice and click OK.

Note: When you enter the sppass command on an Understudy server, you 
are prompted for the password for Understudy administration on that server. To 
change the password on another server, you must enter the sppass command 
as root on the other server.
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Maintenance
There is little special maintenance required for Understudy beyond that which 
is normally required to maintain your servers and services. You will want to 
monitor the log files (/var/log/spare_log.dat). You can truncate them or 
adjust their size as desired as described in “Server Log Menu Options” on 
page 4-8.

Also, refer to “Update Selected Virtual Host” on page 4-8 for details on 
bringing down a primary server for a seamless transition to the backup server.

Troubleshooting
In this section, General Troubleshooting Issues summarizes some basic 
troubleshooting approaches, Error Message Synopsis lists error messages and 
reasons for them, and Log File Message Synopsis does the same for messages 
that may appear in the server log file.

General Troubleshooting Issues
This section describes some situations you may encounter that do not produce 
specific error messages.
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Understudy Considers a Running Service Down
If Understudy indicates that a service is down even though it is running, it may 
be that the service is not sending any information to Understudy. Understudy 
will conclude that it is down even if the TCP connection succeeds. In 
particular, if an HTTP server is monitored by a FTP monitor, the HTTP 
server will be considered down.

Other things to consider if a server is running but Understudy shows it as 
down:

● check that the server is connected to the network 

● check that the network devices and interfaces are properly configured on 
the server

● make sure that the Understudy daemon (the process is called spare) is 
running on the server.

A Virtual Host is Inaccessible
If a site is inaccessible even though Understudy indicates that it is OK, 
remember that Understudy does not take care of replicating data, or starting 
services on virtual hosts. Check that the service is running there, and that the 
actual data exists on the active server. 

Understudy Exits Immediately
If the Understudy daemon exits immediately on starting, refer to the last line 
of the /var/log/polyserve/spare_log.dat for an explanation. A typical 
reason for this is that either the host name is not properly set on the server, or 
the main Ethernet interface is not installed. Refer to the reference manual 
page for ifconfig for ways of checking this.

Browser Accesses Inactive Server
If you access the virtual host from a Web browser which is running on one of 
the servers in a cluster, the browser accesses the service on the server it is 
running on. Note that this allows you to monitor and test the inactive server 
while the virtual host is fully operational.
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Error Message Synopsis
The following section lists Understudy error messages and provides some 
additional information for troubleshooting.

An attempt was made to configure an existing server

If you try to add a server to the cluster and the server is already 
configured on the cluster, you will get this error message.

An attempt was made to configure more than 50 IP addresses. 
However, this version of Understudy only supports 50 IP 
addresses

This version of Understudy does not allow you to configure more than 50 
virtual hosts. Any attempt to configure more than that will prompt this 
message.

An attempt was made to configure more than two servers. However, 
this version of Understudy only supports two servers

This version of Understudy does not allow you to configure more than 
two cluster servers. Any attempt to configure more than that will prompt 
this message.

Sorry, cannot add a virtual host that has the same IP address 
as another machine in the same LAN

This is a safety feature to prevent Understudy from stealing IP addresses 
of other computers on the same LAN. If the user tries to configure a 
virtual host with the same IP address as an existing computer on the 
network, it will prompt this message.

Sorry, cannot add a virtual host whose IP address a.b.c.d is 
already configured in this cluster.

Understudy prevents the user from configuring the same virtual host more 
than once on a given cluster.
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Sorry, cannot add an existing IP address

Understudy does not allow you to configure the IP address of a server as a 
virtual host on the same cluster

Sorry, cannot configure a server which is not on the same subnet

Understudy requires that all servers be on the same subnet

Sorry, cannot configure a virtual host with an IP address which 
is not on the same subnet

Understudy requires that all virtual hosts be on the same subnet

Sorry, cannot delete myself from the list of configured servers

Understudy does not allow you to delete the server it is connected to from 
the cluster.

The address of the requested server is already configured on 
this cluster, which is not allowed

Understudy does not allow you to configure a server that has the same IP 
address as a configured virtual host.

The IP address a.b.c.d of the requested virtual host is already 
held by a configured server on this cluster, which is not 
allowed

Understudy does not allow you to configure a virtual host that has the 
same IP address as a configured server.

Understudy detected that the requested servers (server names) 
are already clustered together and is becoming a singleton 
cluster

Understudy prevents attempts to configure clusters in a cascading way; 
that is, a server may not be in two clusters. For example, if you have a 
cluster consisting of servers A and B, you cannot also have a cluster 
consisting of servers B and C.
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Log File Message Synopsis
The following section lists messages that may appear in the log file 
(spare_log.dat) and provides some additional information on each.

Internal error at server serverid: too many services are 
configured on this host. Understudy recommends that you delete 
some.

If too many service monitors are configured on a given virtual host, 
monitoring the corresponding services requires too many system 
resources. This is Understudy’s way of letting you know about it. There is 
no fixed limit here, but rather something Understudy learns on the fly.

Understudy encountered a bogus line in the configuration file 
/etc/polyserve/spare_conf.dat. Someone might have edited this 
file. The offending line is:

This means that the server’s cluster configuration file has been corrupted. 
This file normally maintains cluster information across reboots. A 
presumably correct file is automatically re-created, but this message is to 
inform you that you should look at the cluster to verify that it is configured 
correctly.

An error occurred while trying to read configuration file /etc/
polyserve/spare_conf.dat

A likely reason for this error is that someone has deleted the file or 
directory. See the previous message discussion.

Understudy found that the hostname is not properly set on this 
machine. Please set the host's name in a proper manner. Exiting.

Understudy cannot be started on computers in which hostname was not 
properly set with regards to the networking configuration. “Properly set” 
means that the hostname must be correctly mapped to the Ethernet 
interface address in /etc/hosts or your name service. A common reason 
for this is that the hostname was set with the hostname command, rather 
than through the formal way of doing this. Consult your system 
administration manual to figure out how to properly set the hostname.
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Understudy received a message with false signature. The message 
is being ignored for security reasons. The offending message is:

Understudy signs messages between the GUI and the daemon. It is 
possible that someone is trying to send bad messages to the daemon.

Understudy received an out of order message. The message is 
being ignored for security reasons

Understudy sequences messages to prevent replay attacks. Someone 
might be trying a replay attack against your host.

Understudy: There does not seem to be any Ethernet device 
defined for this host, or the hostname is not properly set on 
this host. Exiting!

The Understudy daemon cannot start if the Ethernet device or hostname 
are not properly set. Use ifconfig to check that the main Ethernet 
interface is configured on your machine.

Understudy: License Error on Server x.x.x.x: Expired on mm-dd-
yyyy. Spare will be terminated in 2 hours.

The Understudy daemon has recognized a license violation. Every 15 
minutes this message will be repeated. After two hours, Understudy will 
time out and Spare will terminate. It may be started again, but this process 
will continue. Contact PolyServe support to get a valid license or to install 
your license code correctly.

Firewall Information
Understudy uses UDP ports 9040 and 9045 internally, and uses TCP port 
9050 on the cluster servers for Understudy console communication.
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